
Евгения Cherished Эвоян  

Просто и ясно о фотографии для 

начинающих 

Экспозиция фотографии для начинающих. 

Три кита фотографии. 

Итак, начнем с самого начала. Наша камера всего лишь устройство, собирающее свет, 

отраженный от различных предметов, то есть основа всей фотографии и всех тех снимков, 

которые вы получаете одним нажатием кнопки – это свет. И, грубо говоря, от того, 

сколько света попадет на светочувствительную поверхность внутри вашего фотоаппарата, 

зависит  будет ли наш кадр нормальным, темным или слишком светлым, а выражаясь 

терминами фотографии – недоэкспонированным, с нормальной экспозицией или 

переэкспонированным, как в примере ниже. 

 

Пример фото с различной экспозицией. Экспозиция фотографии обозначается символом 

EV и равна 0 при нормальной экспозиции. Отклонения в + или - означают, что кадр 

переэкспонирован или недоэкспонирован. 

В автоматическом режиме камера сама выбирает подходящие настройки так, чтобы 

получилось нормальная экспозиция, однако, во-первых при сложном освещении камера не 

всегда справляется со своей миссией, а во-вторых, если мы хотим научиться фотографии и 

не просто щелкать кнопочкой, а щелкать так, чтобы получать именно такие кадры, какие 

нам надо, просто необходимо научиться фотографировать в ручном режиме. Но не будем 

забегать вперед, давайте для начала просто поймем, что за такие параметры и для чего они 

вообще нужны. 

Основных настроек всего три и все они, каждая по своему, регулируют количество света, 

попадаемого на светочувствительную поверхность. 



1. Диафрагма – размер «дырки», открываемой фотоаппаратом, через которую 

проходит свет. Соответственно чем больше «дырка», тем светлее будет ваш кадр.  

2. Выдержка – время, на которое в фотоаппарате открывается доступ света к 

матрице. Чем дольше это время, тем больше света проникнет на матрицу и тем 

светлее фотография.  

3. Светочувствительность –ISO – этот параметр уже относится к самой матрице. 

Чем выше светочувствительность, тем больше света за единицу времени матрица 

принимает.  

Однажды, на просторах интернета я столкнулась с одной аналогией этих трех 

параметров, которая мне очень запомнилась. Думаю, запомнится и вам. 

 

Представьте себе человека загарающего на пляже. Диафрагмой в таком случае будет 

площадь его тела, не намазанная солнцезащитным кремом . Выдержка – это время, 

которое он проведет лежа под солнцем, а ИСО – это чувствительность его кожи: есть 

люди с высокой чувствительностью, которые моментально обгарают, а есть с более 

низкой чувствительностью, которые при тех же условиях получают меньший загар. Так 

вот при всех этих условиях степень загорелости человека и будет экспозицией нашего 

кадра . 

 

Если это слишком вычурный пример, для ясности представлю вам классический пример: 

окно в вашей комнате. Площадь окна – это размер диафрагмы, задвиньте шторы 

(призакройте диафрагму) и получите меньше света, и соответственно, в комнате станет 

темнее (кадр будет недоэкспонирован). Время, в течение которого открыты ставни, – 

выдержка. Чем дольше продержите окно открытым, тем больше света «наберется» в 

вашей комнате. И последнее светочувствительность – наденьте темные очки и ИСО 

уменьшиться, т.е. уменьшится ваша способность принимать свет. 

Все три параметра в совокупности воздействуют на количество света, воспринимаемого 

матрицей фотоаппарата, поэтому экспозиция зависит от всех параметров. Невозможно 

выделить какой-то один из них и изменить, не изменив при этом уровень экспозиции. 



Однако при этом этими параметрами можно по-разному управлять, чтобы получить тот 

же уровень экспозиции. 

Диафрагма в фотографии: что такое и как 

использовать? 

В прошлой статье мы разобрались, что же из себя представляет экспозиция и слегка 

прошлись по трем основным параметрам фотографии – диафрагме, 

светочувствительности (ISO) и выдержке. Теперь же рассмотрим подробнее один из 

них – диафрагму, освоив работу с которой вы получите наверное один из самых 

художественных и красивых инструментов фотографии. 

Что же такое диафрагма? 

Итак, как мы уже отмечали, диафрагма в фотоаппарате регулирует размер отверстия в 

объективе в момент съемки. Когда вы нажимаете кнопку спуска на фотоаппарате, 

отверстие открывается, пропуская свет к светочувствительному элементу вашей камеры, в 

частности, к матрице, если у вас цифровой фотоаппарат. И именно значение диафрагмы, 

указанное вами при съемке или установленное автоматически фотоаппаратом, регулирует 

размер “дырки”. И это один из тех случаев, когда размер имеет значение  

Судите сами: 

 

На первой верхней фотографии диафрагма очень открыта и вы видите только передний 

бампер первой машинки, окошко уже размыто и не в фокусе, а о том, что там дальше на 

заднем плане приходится только догадываться. На следующей фотографии (правой 

верхней) диафрагма тоже считается открытой и вы видите, что вторая и последующие 



машинки размыты, но первая уже больше в фокусе и “размытость” начинается где-то с 

заднего колеса. 

Закрываем диафрагму еще больше: на нижнем левом фото третья и последующие 

машинки уже размыты , однако их очертания более четкие, нежели на первой фотографии. 

И на самом последнем фото диафрагма закрыта максимально – это не значит, что она 

закрыта совсем, иначе как бы мы получили изображение? Просто размер дырки 

минимален, и вот все машинки в ряд в фокусе и стройненько видны. 

Диафрагма фотоаппарата на английском называется Aperture или f-stop- этот термин 

может часто вам встречаться, и обозначается “f/” и цифрой, которая и будет показывать 

степень открытости/закрытости диафрагмы. 

 

Схема размеров диафрагмы фотоаппарата: чем меньше значение, тем больше открыта 

диафрагма и наоборот 

Итак, на данном этапе достаточно просто запомнить, что чем меньше цифра рядом с f/, 

тем более размыт будет фон, т.е. диафрагма открыта,  и чем больше эта цифра, тем более 

четким будет фон, т.е. диафрагма будет закрытой. 

Почему же диафрагма является одним из наиболее художественных инструментов в 

фотографии? Потому что, регулируя значение именно диафрагмы и фокусируясь на 

нужном объекте, фотограф сам выбирает, на чем акцентировать внимание зрителя и как 

бы приковывает взгляд к тому, что хочет подчеркнуть в фотографии. Посмотрите на 

разницу этих двух фотографий. Какая из них красивее и выразительнее? Куда вы 

посмотрели в первую очередь? 



 

Пример фотографии цветка с открытой и закрытой диафрагмой 

С открытой диафрагмой обычно очень выразительными получаются фотографии цветов, 

бабочек и прочей насекомой живности, портреты людей, с размытым задним фоном, или 

когда необходимо выделить одного человека на фоне остальных. 

 

Портрет и цветок, сфотографированные с открытой диафрагмой 

Тогда как с закрытой диафрагмой фотографируют,  например, толпу, улицы или пейзажи, 

где необходимо, чтобы не было размытости и весь пейзаж был в фокусе. 



Здесь мы плавно подходим к понятию глубины резкости в фотографии, которая 

представляет собой то расстояние, в котором объекты в кадре резкие и в фокусе. Но об 

этом поговорим в следующий раз. 

Что такое выдержка? 

В статье про экспозицию мы слегка коснулись того, что такое выдержка в фотографии. 

Теперь давайте познакомимся с ней поближе. 

Если коротко, то выдержка – это время, в течение которого открывается шторка 

(шторный затвор или просто затвор, да-да, в фотоаппарате есть и такое ), 

пропускающая свет к матрице. 

Выдержка измеряется в долях секунды и если вы переключите камеру на ручной режим, 

режим “M”, который есть даже в мыльницах, или на режим приоритета выдержки “Tv” 

(правда он есть только на зеркалках) вы заметите дробные цифры 1/1000, 1/500, 1/250, 

1/125 и так далее. Это доли секунды, то есть при значении выдержки в 1/1000 затвор 

открывает доступ света к матрице всего на время в 1000 раз короче секунды – неплохо 

правда? 

Выдержка в доли секунды, считается короткой. Она может быть и длиннее, то есть 

дольше по времени – 1, 2, 4 и более секунд (обычно до 30), которые обозначаются 

цифра+кавычка, вот так: 1″, 2″, 4″ и т.д. до 30″. 

А теперь немного о практическом значении коротких и длинных выдержек: 

 В большинстве случаев вы, возможно, будете использовать выдержку не длиннее 

1/60, потому что при более длинных выдержках сложно держать камеру 

неподвижно в руках и вы скорее всего получите “шевеленку” – смазанность 

изображения из-за дрожания рук в то время, когда затвор открыт. Поверьте, руки 

дрожат у всех, даже трезвых, просто это становится явно заметно при длинных 

выдержках . 

 Для фотографирования на выдержке длиннее 1/60 вам необходибо будет обпереть 

руку или локоть обо что-нибудь, либо поставить фотоаппарат на ровную 

поверхность (не забудьте все-таки предварительно накинуть ремешок на шею, 

чтобы случайно не обронить камеру) или воспользоваться штативом. 

 Значение выдержек на вашей камере изменяется в два раза, т.е. при выдержке в 

1/100 пропускается в 2 раза меньше света, чем при выдержке в 1/50. Это 

называется шагом выдержки и является очень удобным подспорьем для оценки 

экспозиции, когда вы изменяете параметры в ручном режиме. Но об этом 

поговорим в отдельной статье. 

 В зависимости от модели и марки фотоаппарата бывают также промежуточные 

значения, например, между 1/100 и 1/200 будет еще 1/125 и 1/150, однако шагом 

или основными считаются те значения, при которых скорость затвора 

увеличивается или уменьшается в два раза. 

Выдержка – это не только еще один способ контроля экспозиции кадра, но и инструмент 

для получения интересных эффектов в фотографии. Вопрос лишь в том, как вы хотите 

запечатлеть движение? 



Чем дольше выдержка, тем больше движения запечатлеет камера, короткая выдержка 

“останавливает” мгновение. 

Самый удачный пример – это вода. При фотографировании на длинной выдержке вода 

получается в виде плавного потока, а при фотографировании с короткой выдержкой она 

“застывает” и даже удается разглядеть отдельные капли. 

 

Фотография воды с разными значениями выдержки 

С длинной выдержкой также фотографируют ночной город или движение машин, однако 

при этом обязательно используется штатив. 



 

Фотография ночного города. Выдержка 30 сек. 

С короткой выдержкой же красиво получаются любые падающие объекты, вода, 

фотографии людей в прыжке и все, на что хватит вашей фантазии. 

 

Фотографии брызг. Выдержка 1/1600 

Если вы не знаете, при какой минимальной выдержке можно фотографировать с рук и не 

получить при этом шевеленки, воспользуйтесь простым правилом: знаменатель значения 

выдержки должен быть несколько больше, чем значение фокусного расстояния объектива. 



То есть если у вас фокусное расстояние в 50мм, то выдержка в 1/60 не даст шевеленки, 

если же у вас  фокусное расстояние в 200мм, то выдержку нужно поставить в 1/250. 

Основы фотографии: 

Светочувствительность, ISO 

В предыдущих статьях мы рассмотрели диафрагму и выдержку, сегодня же рассмотрим 

последний кит фотографии – светочувствительность (ISO). 

Cветочувствительность представляет собой меру того, насколько матрица, в случае 

цифрового фотоаппарата, или пленка, в случае пленочного, чувствительна к свету. И если 

раньше, во времена пленочных фотоаппаратов, для изменения светочувствительности 

фотографу приходилось менять всю пленку, то сегодня в цифровых фотоаппаратах она 

изменяется нажатием пары кнопок. 

Светочувствительность измеряется в единицах ISO и обычно принимает значения 100, 

200, 400, 800 и т.д. до 6400, причем каждое последующее значение ISO увеличивает 

светочувствительность в 2 раза. Более высокие значение ISO обычно используются при 

плохом освещении, чтобы получить возможность фотографировать на более короткой 

выдержке, однако ценой этому является цифровой шум (множество разноцветных мелких 

точек, появляющихся на фотографии). Вот как здесь: 

 

Приближенные изображение цветка. Слева ISO 3200, справа ISO 100 

Значения ISO, при которых на фотографиях появляется шум, напрямую зависит от 

размера матрицы. Именно поэтому, на мыльницах, у которых физические размеры 

матрицы маленькие, уже при фотографировании с 400 ISO может появляться цифровой 

шум, тогда как при съемке камерой с полноформатной матрицей шум начинает 

появляться при значениях ISO в 1600 или 3200. 

Для того, чтобы выбрать оптимальное значение светочувствительности при 

фотографировании быстренько оцените ситуацию: 

1. Достаточно ли света, чтобы фотографировать на минимальном значении ISO? 



2. Хотите ли вы получить фотографию с шумом или нет? Иногда, особенно на черно-

белых фотографиях шум смотрится достаточно эффектно, в таком случае можно 

смело увеличивать значение ISO. 

3. Есть ли у вас штатив или возможность закрепить фотоаппарат, чтобы 

компенсировать светочувствительность более длинной выдержкой? Если да, то 

можно оставить низкое значение ISO и увеличить выдержку, если нет, то во 

избежание шевеленки придется поднять ISO. 

4. Движутся ли объекты, которые вы собираетесь фотографировать, или они 

неподвижны? Если движутся, то придется поднять ISO, иначе фотографии 

получатся смазанными. 

Вот примеры некоторых ситуаций, когда вам, скорее всего, придется использовать 

высокое значение ISO: 

 спортивные мероприятия, танцы, детские праздники в помещении, когда 

необходимо фотографировать на короткой выдержке, чтобы не получить смаз. 

 в музее, церкви, галлерее, где использование вспышки может быть запрещено 

 торт со свечами в день рождения, когда именинник готовиться их задуть. Вспышка 

может просто убить все настроение и загадочность момента и света, поэтому 

лучше просто увеличить ISO. 

И напоследок имейте ввиду, что для смягчения или иногда и полного удаления шума 

существуют специальные программы и плагины к Adobe Photoshop (как например, 

Imagenomic Noiseware Pro) , которые здорово приходят на помощь в ситуациях, когда без 

высокого ISO не обойтись. 

Как фотографировать зеркалкой? 

Полуавтоматические режимы съемки 

 

У вас появился зеркальный фотоаппарат или как его еще называют зеркалка? Что вы 

чувствуете – восторг от того, что теперь будете получать фото шедевры или смятение от 

обилия непонятных режимов и кнопочек? И в том, и в другом случае – это временно, 

потому что фотошедевры – дело наживное, а в фотоаппарате и его кнопочках мы сейчас 

разберемся. 

Конечно, фотографировать зеркалкой можно и в авто режиме, чтобы привыкнуть к весу 

нового фотоаппарата, воочию убедиться в качестве фотографий, но рано или поздно авто 

режима вам окажется мало. 



В предыдущих статьях вы познакомились с основами экспозиции и тремя китами 

фотографии - диафрагмой, выдержкой и светочувствительностью и их особенностями, 

теперь же давайте применим полученные знания на практике! 

Мы не будем сразу переходить к полностью ручному режиму, поскольку в нем много 

своих ньюансов, но чтобы вы уже сейчас начали получать более художественные снимки, 

давайте познакомимся с полуавтоматическими и художественными режимами съемки. 

Как и на цифрокомпактах или мыльницах, на зеркалках есть базовые автоматические 

режимы съемки – портрет, пейзаж, макро, спорт и пр. Все, что вам необходимо сделать – 

это нажать на кнопку спуска. В действительности, фотоаппарат при этом будет 

жонглировать теми же тремя параметрами экспозици и, по тем же самым принципам, что 

и вы, когда начнете фотографировать в ручном режиме. 

Следующий полукруг режимов (P, A (или Av), S (или Tv), M, A-Dep) – 

полуавтоматические, которыми могут пользоваться как начинающие фотографы, чтобы 

получить более эффектные кадры и не заморачиваться насчет настроек, так и опытные 

фотографы с целью экономии времени. 

 

Итак, давайте пройдемся по порядку по основным полуавтоматическим режимам. 



1. Наиболее простым режимом является режим P (от названия программная 

автоэкспозиция, иногда его также называют приоритетом ISO). Суть этого режима в том, 

что вы устанавливаете значение ISO, а фотоаппарат сам подбирает значения выдержки и 

диафрагмы так, чтобы получилась нормальная экспозиция кадра. Этот режим очень 

удобен для практики съемки с различными значениями ISO, а также для понимания того, 

как много значений экспопары – пары выдержки и диафрагмы – могут обеспечить 

получение одного и того же уровня экспозиции. 

При этом вы можете менять значения экспопары, на фотоаппарате Canon 550D это 

делается одним движением ролика: например, если вам необходима более короткая 

выдержка, крутите ролик направо, сокращая выдержку, а фотоаппарат при этом 

призакроет диафрагму, чтобы сохранить экспозицию на том же уровне и позволить вам 

сфотографировать застывшее в воздухе яблоко, которое готовится вот-вот упасть на 

голову Ньютону  

Поэкспериментируйте со съемкой в режиме Р, пропобуйте сфотографировать один и тот 

же объект с разным ISO, определите при каком значении ISO вашей камеры на 

фотографиях появится шум. Также обратите внимание на то, как изменяются значения 

выдержки и диафрагмы при изменении экспопары. 

2. Следующий режим – это режим приоритета диафрагмы (A или Av) 

Этот режим позволяет контролировать степень размытия фона на фотографии, т.е. здесь 

вы вручную задаете ISO и регулируете значение диафрагмы, а выдержку камера 

выставляет сама так, чтобы получить нормальный экспонированный кадр.  В этом режиме 

вам необходимо просто определиться, нужен ли вам размытый фон или нет, и поставить 

соответствующее значение диафрагмы, все остальное за вас сделает фотоаппарат. 

 

  

Рассмотрим этот режим на примере моего любимого яблочка с листочками для заметок  :) 

На первом фото было установлено ISO и значение диафрагмы было изменено так, чтобы 

стало максимальным (в данном случае f/1.8)  и мы в итоге получили красивое размытие по 

краям “яблочка”. Несколько движений пальцем (прокручиваем ролик), диафрагма 

закрывается (f16) и мы получаем резкий кадр без размытостей. Обратите внимание, 



что f/1.8 с выдержкой в 1/1250 обеспечили тот же уровень экспозиции, что и f16  с 

выдержкой в 1/15. 

При изменении значения диафрагмы обратите внимание на экран фотоаппарата, если вы 

попытаетесь установить слишком маленькое/большое значение диафрагмы и цифра, 

показывающая выдержку, начнет мигать – это будет означать, что при данном значении 

ISO и том значении диафрагмы, которое вы пытаетесь установить, камера не сможет 

обеспечить нормальную экспозицию. В таком случае измените ISO или значение 

диафрагмы. То же самое происходит и в режиме приоритета выдержки, о котором 

несколькими параграфами ниже  

Если вы снимаете портрет, поставьте ISO и прокрутите ролик до значения самой открытой 

диафрагму, чтобы получить размытый фон, при этом выдержку камера отрегулирует. А 

если вы фотографируете пейзаж, закройте диафрагму, чтобы весь пейзаж оказался резким 

и в фокусе. Однако, если вы снимаете вечерний пейзаж или еще по каким-то причинам 

света мало, обратите внимание на значение выдержки – если она окажется слишком 

длинной, вам придется воспользоваться штативом или поставить фотоаппарат на какую-

нибудь поверхность при съемке, чтобы избежать шевеленки. 

Поиграйте и с этим режимом, он даст вам возможность исследовать, какой эффект дают 

различные значения диафрагмы, и вам при этом не придется задумываться об остальных 

параметрах. 

3. Режим приоритета выдержки – S или Tv. 

Аналогично предыдущим режимам, режим приоритета выдержки позволяет вам при 

заданном ISO контролировать только значение выдержки, оставив диафрагму  на 

усмотрение фотоаппарата. 

 

Так, например, на этих фотографиях ISO было неизменным и был поставлен режим 

съемки Tv, т.е. регулировалась только выдержка. На первом фото выдержка короткая – 

1/2000, что позволило получить застывшие в воздухе капли воды, не задумываясь о 

значении диафрагмы. На втором фото несколькими оборотами ролика выдержка стала 

длиннее – 1/13, посмотрите насколько камера закрыла диафрагму (f/22), чтобы получить 

ту же нормальную экспозицию! 

Для того, чтобы опробовать этот режим вам необязательно искать фонтан, вы можете 

просто выглянуть из окна и попробовать сфотографировать проезжающие машины (если 

они, конечно видны из вашего окна ) : поставьте короткую выдержку, чтобы получить 

четкую фотографию машины “остановленную” в кадре (если будете фотографировать 



солнечным днем, то можете поставить значение выдержки около 1/800, хотя все зависит 

от света в конкретной ситуайии). А теперь сделайте выдержку длиннее, поставьте 

фотоаппарат на подоконник и аккуратненько нажмите кнопку. Вы, скорее всего, получите 

художественный смаз, показывающий динамику уличного движения. 

Поэкспериментируйте с фотографиями на короткой и длинной выдержке, при этом 

присмотритесь к тому, какие значения диафрагмы и ISO выставляет фотоаппарат – это 

поможет Вам лучше понять связь между ними. 

4. И еще один режим – приоритет глубины резкости (A-DEP), который есть не на всех 

моделях. В этом режиме фотоаппарат устанавливает значения диафрагмы и выдержки так, 

чтобы все объекты, попавшие в автофокус, были бы в зоне резкости. Удобен, если вы 

пользуетесь полностью автоматическим режимои и постоянно получаете кадры не в 

фокусе, но стоит вам немного побаловаться ручными настройками или хотя бы 

полуавтоматическими режимами, к этому режиму вы уже точно не вернетесь  

Как фотографировать зеркалкой в ручном 

режиме: инфографика 

Сегодня представляем вашему вниманию интересную и предельно ясную инфографику о 

том, как фотографировать зеркалкой в ручном режиме. Поначалу всегда бывает 

сложно запомнить обо всех параметрах, но это дело практики, а эта небольшая памятка 

напомнит, если вы что-то забудете. Ее даже можно распечатать и носить с собой. Автор 

этой памятки Miguel Yatco, за что ему больше спасибо, а перевод наш  

Также можете предварительно почитать про то, что такое диафрагма, выдержка и 

светочувствительность, а также про настройки экспозиции. 



А вот и сама памятка! 

 

Лайкните и передайте памятку друзьям, интересующимся фотографией, если она вам 

понравилась  



Как узнать данные фотографии: 

волшебный EXIF 

Недавний случай с найденным в интернете фотоаппаратом сподвиг меня написать для 

начинающих о том, что же такое EXIF и какие его полезные применения существуют 

EXIF (от англ.  Exchangeable Image File Format) – это формат, который позволят включать 

в себя дополнительную информацию (метаданные) о фотографии, так например, 

производитель камеры, модель, когда и при каких условиях был сделан снимок, и даже 

сработала ли при этом вспышка или нет. 

EXIF любого снимка можно посмотреть как в фоторедакторах, как Photoshop, смотрелках 

как  ACDSee или даже в Windows. Давайте, рассмотрим, как посмотреть EXIF данные 

фотографии в каждой из этих программ. 

1. Самый простой вариант – посмотреть EXIF фотографии в Windows. Щелкаете правой 

кнопкой мышки на фотографии и открываете меню Properties, далее Details. Вот 

пример EXIF данные одной из моих фотографий: 

 



Так можно увидеть параметры съемки – значение диафрагмы, выдержки, ISO, фокусное 

расстояние, время и дату съемки и много другой информации. Помимо этого, внизу есть 

строка “Remove Properties and Personal Information”, щелкнув на которой вы получите 

возможность удалить все EXIF данные или некоторые по выбору, но об этом позднее. 

2. В ACDSee также просто можно посмотреть EXIF фотографии. Открываете фото в 

режиме просмотра (View) и нажимаете Alt+Enter или заходите в пункт меню File-

>Properties. Слева появится панелька, внизу которой необходимо выбрать вкладку EXIF и 

перед вами откроется вся информация о фото. 

 
3. В Фотошопе EXIF фотографии можно посмотреть, нажав Alt+Shift+Ctrl+I или пройдя 

в меню File->File Info, и дальше выбрав вкладку Camera Data. 

 



  

В Фотошопе просматривать EXIF достаточно муторно, поэтому, на мой взгляд, самым 

удобным в этом смысле является ACDSee: он позволяет посмотреть EXIF всех 

фотографий в папке в том же окошке, без необходимости открывать его заново для 

каждого файла, а также предоставляет возможность изменять некоторые данные, не 

отходя от кассы… в смысле программы  

Предлагаю вам выбрать самые любимые фотографии, посмотреть их EXIF данные и 

проанализировать параметры съемки, думаю, вы найдете там много интересного! 

Как фотографировать при плохом 

освещении: инфографика 

Довольно часто приходится фотографировать при плохом освещении и при этом не 

обязательно быть любителем ночных фотографий, достаточно фотографировать во время 

семейных праздников в помещении или просто вечером. Однако хорошие фотографии 

можно получать даже при таком освещении, достаточно знать несколько незамысловатых 

приемов и владеть той техникой, которая у вас есть. 

Мы уже рассматривали несколько советов по фотографии при плохом освещени, а также 

как фотографировать ночью, теперь самое время все это обобщить   Snapsort 

подготовил прекрасную инфографику о том, как фотографировать при плохом 



освещении, а мы ее перевели на русский. Пользуйтесь на здоровье! 

 



Удачной вам вечерней и ночной фото охоты!  

Как фотографировать себя: 3 простых 

способа съемки автопортрета 

Поскольку у нас на сайте в самом разгаре конкурс автопортрета, то я думаю, не лишним 

будет небольшой урок о том, как фотографировать себя любимого/любимую. 

В целом, с технической точки зрения есть 3 основных способа сфотографировать 

автопортрет, хотя конечно все зависит от вашей фантазии и энтузиазма. В конце этой 

статьи будет тому наглядное подтверждение. 

Так вот способ №1. Просто с руки 

Самое простое и первое, что приходит в голову – взять и щелкнуть! 

Ликуйте счастливые обладатели мыльниц, ваш автопортрет получится намного легче и в 

два щелчка точно! С зеркалкой придется приноровится, поставить автофокус или вообще 

режим авто и для начала посмотреть с какого ракурса вы получаетесь лучше всего, нет ли 

второго подбородка в кадре, если вы снимаете снизу, и не слишком ли задрана голова, 

если снимаете сверху, не видно ли половины “обрезанной” руки – той, которой вы 

держите фотоаппарат? На эти и многие другие вопросы предстоит ответить опытным 

путем. 

Если честно, я ни разу хорошо не получалась при таком способе фотографирования 

автопортрета, поэтому и фото свое не буду показывать, смотрите дальше  

Автопортрет: способ №2. Зеркало. 

Действительно, в зеркале хорошо получаются автопортреты, тем более, что есть 

возможность запечатлеть себя с любимой камерой, вот так! 

 

Это кадр из серии я и мой милый Canon, главное немного потренироваться в позировании 

и смотреть не на себя в зеркале, а в отражение объектива  



Пару советов на заметку при съемке автопортрета в зеркале. 

 Обязательно выключите вспышку 

 Тщательно протрите зеркало, особенно, если вы фотографируете крупным планом. 

Проверьте, чтобы не осталось разводов. Думаю, вам не очень хочется потом три 

часа в фотошопе выравнивать свое лицо только, потому что на зеркале остался 

развод. 

 Постарайтесь сфотографировать себя днем, если к зеркалу есть доступ 

естественного света, или в крайнем случае при хорошем освещении, потому что 

вам придется фотографировать с рук, а длинных выдержек без шевеленки вы не 

выдержете  

 Постарайтесь сделать автопортрет так, как будто вас фотографируют с аппаратом, 

а не вы фотографируете себя, морщась глядя в видеоискатель. Включите режим 

lifeview, чтобы видеть всю картину на дисплее и расслабьтесь Сделайте 

несколько пробных кадров и позируйте! 

 Да, и наверное самое важное – смотрите не на себя, а в отражение объектива в 

зеркале. 

Интересным также получится автопортрет, снятый в маленьком зеркальце, так, чтобы не 

было видно фотоаппарата, но была видна рамка зеркала, а все остальное за ним 

художественно размыто. Примерно вот так: 

 

Здесь я держу камеру правой рукой где-то на уровне глаз чуть впереди меня, диафрагма 

открыта до 1.8, чтобы фон был очень размыт и все внимание было направлено на 

портрет. 

Поскольку в этих случаях вы будете ограничены в перемещении и изменении ракурса, 

продумайте заранее, как лучше расположится по направлению к свету и какую позу 

принять. Например, в процессе снятия этой фотографии мне пришлось подложить под 

локоть коробку из-под салфеток потому что рука на весу дрожала и фокус постоянно 

терялся  

Автопортрет способ №3. Штатив и пультик/таймер. 
Это наверное самый муторный, но в то же время дающий наибольшую свободу в плане 

выбора вашего расположения в кадре, позы, света и пр. 

Вам понадобятся – минимум камера, максимум – штатив, пультик, может еще и iPad, 

чтобы подключить к нему видоискатель и смотреть на себя в iPad-е  

Значит, при программе минимум: 



 ставим камеру на устойчивую ровную поверхность, где минимальна вероятность ее 

падения 

 смотрим, что у нас попадает в кадр, очищаем задний фон от ненужных вещей 

 примерно представляем, где и как будем стоять/сидеть/лежать, какую позу и 

выражение лица примем  

 устанавливаем желаемые настройки камеры, фокус придется либо оставить авто, 

либо посадить на свое место плюшевого мишку и установить ручной фокус по 

нему 

 закройте диафрагму где-то до f/8, при маленькой глубине резкости вам придется 

долго охотиться за фокусом в нужном вам месте 

 ставим таймер на режим ожидания 10 сек. и за это время усаживаемся как надо и 

позируем 

 смотрим результат, при необходимости повторяем заново. 

При программе максимум, последовательность та же, только вам не придется думать, что 

камера может упасть или находится на неудобной высоте – штатив разберется, не 

придется спешно усаживаться в течение 10 сек., а вы будете видеть свой автопортрет в 

видеоискателе (iPad или даже телевизоре) и нажмете кнопочку пультика, когда будете 

готовы  

Вот этот кадр был сделан со штатива в режиме задержки 10 сек. с последующей съемкой 

7-8 кадров друг за другом, очень удобная функция кстати,  - позволяет изменять позу, 

выражение лица на разных снимках. Обычно при этом последние получаются более 

непринужденные  

 
 

Как фотографировать салют: 5 советов 

Поскольку завтра будут празднования 20-летия Независимости Армении и явно будет 

большой и красивый салют, предлагаем Вашему вниманию 5 небольших советов о том, 

как фотографировать салют. 

Начните с того, что подготовьтесь к мероприятию заранее, продумайте место съемки – на 

главное здание площади или крышу музея вас могут не пустить, но возможно у вас есть 

друг, живущий неподалеку, из окна дома которого откроется прекрасный обзор. Сделайте 

пару тестовых снимков, чтобы определиться с композицией кадра, основными 

настройками и фокусными расстоянием. 



1. Запечатлейте движение фейерверка. Для этого вам понадобится штатив и длинная 

выдержка, около 1 секунды скорее всего будет достаточно, чтобы получить не просто 

огоньки, а весь “путь” салюта.  А еще лучше фотографировать в режиме BULB, когда 

длина выдержки регулируется вручную: при первом же признаке взлета снаряда 

нажимаете на кнопку спуска, и отпускаете ее, когда салют будет в самом красивом 

состоянии Если же фейерверк идет в несколько залпов подряд, то можете подержать и 

подольше, тогда получится кадр с несколькими салютами одновременно. 

Что делать, если нет штатива? Вам на выручку придет обыкновенный мешочек с рисом 

или любой другой крупой – поставьте его на удобное место, чтобы фотоаппарат 

ненароком не выпал, и чтобы открывался вид на предполагаемый салют, зафиксируйте на 

нем камеру и вперед! 

2. Настройки диафрагмы. При слишком открытой диафрагме цвета получатся 

недостаточно насыщенными, поэтому прикройте диафрагму до примерно f/8 и будьте 

готовы пересмотреть параметры, как только начнется фейерверк. 

3. Какое значение ISO выбрать? Поставьте самое маленькое значение ISO (100 или 

200 вполне подойдут в зависимости от того, насколько близко или далеко вы находитесь 

от салюта), чтобы избежать шума, а света будет предостаточно, поскольку сам фейерверк 

прекрасный источник. Да, и не забудьте выключить вспышку, поскольку она все равно не 

достанет  

4. Фокусное расстояние. Если вы фотографируете с близкого расстояния, то скорее всего 

вам понадобится широкоугольный объектив, если же нет, то будьте готовы изменять зум 

по ходу фейерверка, чтобы либо заполнить им кадр, либо показать его на фоне города, 

например. Фокус ставьте на бесконечность. 

5. Расслабьтесь и получите максимум удовольствия. Даже если что-то пошло не так, не 

расстраивайтесь, отставьте камеру в сторону и насладитесь великолепным зрелищем 

салюта. Когда еще Армении будет 20 лет!  

И напоследок сегодняшнее фото дня от National Geographic, которое по интересной 

случайности также про фейрверк. На этом фото автор не стал делать классическое фото 

салюта, а поставил длинную выдержку в 3 секунды, в результате чего получился такой 

огненный “взрыв”, который, однако прекрасно отражает сущность и настроение 

просходящего. 



 

Winter Carnival, Saranac Lake, New York. Photograph by Mark Kurtz 

Зачем нужен EXIF и как его 

редактировать 

EXIF данные действительно содержат большое количество информации о фотографии, 

однако когда дело доходит до выкладывания фото в интернет, что в наш век делает 

практически каждый, встает двоякий вопрос – оставлять или удалять эти данные. 

EXIF полезен тем, что содержит подтверждение того, что снимок сделан с вашей камеры, 

что, например, может помочь найти украденный фотоаппарат. Также EXIF полезен просто 

при изучении фотографий мастеров, когда вам интересно, как были выставлены 

диафрагма, выдержка и остальные параметры съемки. Вот как, например, на сайте 

500px.com: 

http://photolunch.ru/wp-content/uploads/2011/09/fireworks-1.jpg


 

Однако, EXIF может содержать если не конфиденциальную, то, по крайней мере, 

нежелательную для показа всему интернету информацию. В таком случае возникает 

необходимость удалить эти данные,  хотя это не исключает случаев удаления EXIF с 

целью просто скрыть чей это снимок и использовать в качестве своего. В общем, это 

достаточно сложный вопрос, и вам решать – удалять или оставлять EXIF данные, моя же 

цель – показать как  

Начнем с того, что есть прекрасный сервис StolenCameraFinder.com, который в случае 

потери камеры подскажет ее серийный номер, даже если вы его не записали, и 

автоматически найдет фотографии с вашей камеры – вам всего лишь необходимо закинуть 

в окошко этого сайта один из прошлых снимков, снятых вашей камерой. Правда тест с 

моими фотографиями дал всего 4 результата хотя моих фотографий в сети в сотню раз 

больше. 

GadgetTrack.com, ставший еще более популярным благодаря тому, что помог найти 

украденный фотоаппарат, действительно выдал намного больше результатов по моим 

фотографиями – в целом, по данным сайта, они проиндексировали более 10.4 млн. 

серийных номеров. Однако, этот сервис автоматически не определяет серийный номер: 

для этого вам придется заглянуть в EXIF одного из своих снимков самостоятельно, 

согласно одному из методов, показанных в статье про то, как узнать EXIF данные 

фотографии. 

Что же делать, если вы все-такие не хотите раскрывать подробностей фотографии? 

Опять же способов здесь несколько. 

1. Самый простой способ редактировать EXIF был описан еще в прошлом уроке – 

просто жмете правой кнопкой мышки на файл и заходите в пункт меню Properties, 

заходите во вкладку  Details и жмете на ссылку Remove Properties and Personal Information. 

В открывшемся окне выбираете, какие данные удалить, а какие оставить и оставить ли 

вообще. 



 

2. Следующий способ удобен при обработке фотографии и ее сохранении для 

последующего опубликования в интернете. В фотошопе есть специальная функция для 

этого File -> Save for Web & Devices или просто наберите t+Shit+Ctrl+S. Здесь вам 

необходимо выбрать формат файла, в частности, jpg и в поле metadata указать, как вы 

хотите редактировать exif данные – что оставить, а что убрать, или вообще удалить все 

exif данные. 



 

3. И еще одно простой способ редактировать EXIF данные  - это 

сервис http://exifremover.com/, который позволяет не только удалять, но и редактировать 

EXIF он-лайн. Это достаточно удобный сервис, особенно когда под рукой нет фотошопа, 

правда на нем слишком много рекламы, осторожно жмите мышкой  

Какими еще сервисами по работе с EXIF вы пользуетесь? Какие наиболее удобные? Буду 

рада вашим комментариям 

Как правильно фотографировать при 

плохом освещении 

 



Фото со дня рождения ребенка. f/1.8, 1/80, ISO 800 

Иногда бывает необходимо фотографировать при плохом освещении без использования 

вспышки, например, когда не разрешается фотографировать со вспышкой, когда вспышка 

может испортить натуральное освещение или просто когда нет с собой внешней вспышки, 

а встроенная вспышка в лоб только все испортить. В общем, какие бы причины на то ни 

были, из любой фотоситуации всегда есть выход и хорошие фотографии можно сделать и 

без вспышки. 

Итак, 3 шага как получать хорошии фотографии при плохом освещении: 

Шаг 1.Ставьте максимум светочувствительности, ISO. Чем выше ISO, тем больше 

чувствительность матрицы к свету, на Canon 550D максимальное ISO 6400, однако мне 

еще не приходилось им пользоваться, максимальное ISO, которым я пользовалась 1600. 

Да, получаются фотографии шумные, но потом всегда можно воспользоваться шумодавом 

или просто сделать фото в черно-белом формате, при котором шум придаст фотографии 

особый эффект. Фотографируйте в RAW формате, чтобы иметь большую возможность 

последующего редактирования фотографии. 

Шаг 2. Открытая диафрагма. Вы помните, что чем больше диафрагма, тем больше света 

пропускается к матрица? Открывайте диафрагму по максимуму, насколько позволяет ваш 

объектив. Хотя здесь речь не идет о ночной съемке улиц, например, где иногда бывает 

необходимо закрыть диафрагму, так что мы поговорим об этом в одной из следующих 

статей про эффект звездочек в ночной фотографии. 

Шаг 3. Выдержка как можно дольше. Да, обычно при выдержке длиннее 1/60 и съемке с 

рук появляется шевеленка, но мне удавалось получать не размытые кадры и при более 

длинных выдержках, самое главное – вовремя обпереться обо что-то и использовать 

объективы со встроенной стабилизацией изображения. Экспериментируйте! Однако, при 

совсем длинных выдержках, конечно, без штатива не обойтись. 

Ну и напоследок, если все-таки приходится использовать вспышку, постарайтесь не 

пользоваться встроенной вспышкой, которая визуально “сплющивает” объект, потому что 

светит прямо на объект, как этот процесс еще называют “пыхой в лоб” И обязательно 

внесите внешнюю вспышку в список покупок  

Главное, не бойтесь экспериментировать, потому что главное в фотографии – 

фотографировать и получать от этого удовольствие,  а не опускать руки, видя заведомо 

плохое освещение. Удачных вам ракурсов! 

Как фотографировать ночью: режимы 

съемки 

Ночью все вокруг просто преображается и фотографии приобретают особый шарм, однако 

вместе с тем режим авто не срабатывает как надо и фотографировать ночью приходится 

полностью на ручном режиме. 

Чтобы разобраться со всеми настройкам, представлям вам 5 советов о том, как 

фотографировать ночью. 



1. Обязательным условием ночной съемки является штатив или, в крайнем случае, 

устойчивая поверхность, потому что света для съемки на коротких выдержках 

недостаточно, а шум, получаемый в результате высокого ISO, будет слишком отчетливо 

виден в темных участках фотографии, которых на ночной фотографии более чем 

достаточно  

2. Полностью ручной режим съемки, потому что ни замер экспозиции, ни автофокус, ни 

тем более встроенная вспышка в экстремальных условиях ночной съемки не справятся как 

надо. Поэтому ставим замер экспозиции по участкам со средней освещенностью, фокус – 

ручной на главный объект в кадре, вспышку даже не включаем, потому что встроенная 

пыха вряд ли достанет до находящегося от вас в нескольких десятках метров здания или 

просто улицы, а скорее всего просто осветит ближайший объект, а все самое интересное 

останется темным. Можете также почитать о том, как фотографировать в ручном режиме 

или посмотреть интересную инфографику по этой же теме. 

3. Настройки диафрагмы, выдержки и ISO. Как уже было сказано выше, шум от 

большого значения ISO испортит нам весь кадр, поэтому оставим его минимальным и 

компенсируем более длинной выдержкой. Про диафрагму пойдет отдельный разговор в 

следующей статье но до этого, поэкспериментируйте с разными настройками и 

поделитесь результатом! Какой эффект вы получили? 

4.  Самая большая проблема при ночной съемке – это баланс белого, потому что на 

улицах большое количество совершенно разного света, разного цвета (прямо в рифму) и 

наиболее оптимальным является фотогарфирование на автоматическом балансе белого в 

формате RAW, а потом его коррекция при пост-обработке. 

 

Canon 550D, 55mm, f/7.1, 3.2", ISO400 



5. Пультик, тросик или таймер для съемки с задержкой в 2 сек., если у вас нет 

пультика или тросика обязательно включите этото режим, потому что даже от нажатия на 

кнопку спуска в кадре может появится шевеленка. Помните, мы фотографируем на 

длинной выдержке? В некоторых случаях может быть нужна выдержка длиннее 30 сек., 

тогда включаем режим BULB и фотографируем как в статье про то, как фотографировать 

салют. 

Ночная фотография – особый вид фотоискусства. Хорошие ночные фотографии 

получаются методом проб и ошибок, пробуйте различные настройки, а мы в следующей 

статье расскажем про некоторые интересные приемы и эффекты в ночной фотографии. 

Что вас интересует в ночной фотографии? Что вы любите фотографировать ночью? 

Как фотографировать ночью: эффект 

звездочек на фонарях 

В прошлый раз мы рассмотрели общие настройки фотоаппарата и технику, необходимую 

для фотографирования ночью, но один вкусный эффект оставили на сегодня. Вы 

попробовали изменять значение диафрагмы? Каков был результат? 

Закрытие диафрагмы дает потрясающий эффект звездочек на ночных фотографиях, если 

вы фотографируете какой-либо постоянный источник света – уличные фонари или елку, 

например  

При открытой диафрагме свет от фонарей получается в виде большого размазанного 

шарика, а стоит закрыть диафрагму – как появляются эффектные “лучики”.  Вы даже 

можете попробовать посмотреть на фонари, а потом призакрыть глаза – система та же  

Количество “лучиков” на каждом фонарике изменить невозможно, потому что оно 

зависит от количества лепестков диафрагмы объектива, которым вы снимаете. Если 

количество четное, то и число лучиков будет соответствующим, а если нечетное 

количество лепестков диафрагмы, то лучиков будет в 2 раза больше, то есть при 5 

лепестках получится 10 лучиков. 

Вот наглядный пример: 



 

6 лучиков диафрагмы, китовый объектив Canon 18-55, 25'', f22, ISO 100 

и вот этот снимок, сделанный уже на другой объектив с другим числом лепестков 

диафрагмы, лучиков, соответственно, больше и звездочки получились “пушистее”  

 

9 лепестков диафрагмы и 18 лучиков, Canon 55-250, 3.2'', f/22, ISO400 



Аналогичный эффект звездочек на фонарях или елке, как на фото ниже, можно получить и 

при помощи специальных звездных фильтров, однако если у вас нет такого фильтра – не 

беда, поиграйте с настройками диафрагмы и все обязательно получится. 

 

Использование звездного фильтра. Фото Kevin & Amanda Photography 

UPD. Еще один дельный способ получения эффека звездочек на фотографии с 

использованием подручных средств,  подсказал leviafan. 

Для этого вам поднабоиться старый светофильтр, который отслужил свой срок. Делаете на 

нем, хоть гвоздем, хоть ещё чем либо горизонтальные и вертикальные линии, и в 

пересечении линий получите теже самые зведочки от фонарей. Жестокий метод, но 

проверенный, тем более что вы можете регулировать количество фонарей со зведочками, 

хотите один, хотите несколько. А это интереснее, когда один фонарь со зведочкой, а 

остальные нет. 



Новогодние фотографии: как получить 

эффект боке 

 

Эффект боке на фотографии получился от елочной гирлянды, расписные стаканы на 

переднем плане установлены так, чтобы огоньки "выливались" из одного стакана в 

другой. Canon 550D, 50mm, f1.8 

Скоро, совсем скоро Новый Год и наверняка все уже давно нарядили новогоднюю елку, а 

это прекрасный повод фотографировать, вопрос лишь в том как?! Новогодние огни на 

елке – прекрасный способ получить эффект боке на фото, а добавив немного креатива вы 

получите интересные фотографии с эффектом боке. 

Название “боке” (на англ. bokeh) произошло от японского слова, 

означающее «размытость» или «нечёткость», а на фотографии оно проявляется в участках 

находящихся вне фокуса, особенно при съемке с открытой диафрагмой. 

Так давайте попробуем использовать этот эффект специально, а на примере елочных 

гирлянд боке сможет сделать каждый! 

1. Первое что нам понадобится это светосильный объектив, чем больше у него 

диафрагма, тем лучше. Эти фотографии сделаны на 50мм объектив Canon с 

диафрагмой в 1.8. Однако, если даже у вас нет светосильного объектива, боке 

можно получить и китовым объективом и даже обыкновенной мыльницей или 

цифрокомпактом. 

2. Развешиваем красиво гирлянды, если же елка уже наряжена, то можно 

сфотографировать что-то, например, новогоднего дракончика или просто игрушки, 

бокалы с шампанским и все на что хватит вашей фантазии, на фоне елки с 



горящими огоньками. Чтобы получить эффект боке, расположите то, что 

собираетесь фотографировать как можно дальше от гирлянды, но на ее фоне. 

3. Разместили? Прекрасно, теперь самое время выключить свет и желательно 

поставить камеру на штатив или на любую устойчивую поверхность, потому что 

нехватку света возможно придется компенсировать длинной выдержкой. 

4. Объект съемки ставите как можно ближе к фотоаппарату и подсвечиваете его 

сбоку либо вспышкой, софтбоксом или любым другим источником света, хоть 

карманным фонариком. Главное, чтобы свет не падал в сторону источника нашего 

боке.  

5. Открываете диафрагму насколько позволяет ваш объектив, можете при этом даже 

воспользоваться полуавтоматическим режимом приоритета диафграгмы (Av). 

Выставляете ручной фокус на объекте съемки и фотографируете! Должно 

получится волшебно-красиво  

Как получить эффект боке китовым объективом? 

Для этого повторяем те же шаги – открываем диафрагму, поворачиваем кольцо зума по 

максимуму, ставим ручной фокус на близкий объект. Однако, чтобы получить эффект 

боке китовым объективом, необходимо увеличить расстояние до фона и источника света 

для боке, то есть нужно будет фотографировать более далекие источники света, например, 

уличные фонари. 

Вот на фотографии ниже эффект боке получен китовым объективом Canon 18-55mm, 

 фокусное расстояние было около 30 мм, а диафрагма f/4.5. Фокус был на каплях дождя на 

окне, а эффект боке получился от света фар машин на улице. 

 

Canon 550D, 30mm, f/4.5, ISO1600 

В идеале эффект боке китовым объективом получится еще лучше при максимальном 

фокусном расстоянии этого объектива, т.е. где-то на 50-55мм, правда тогда диафрагма 

будет менее открыта, но всегда есть простор для эксперимента и творчества! 



С наступающими праздниками!!! Фотографируйте и делитесь с нами красотой вокруг вас! 

Новогодние фотографии: 10 идей и советов 

Итак, до Нового года осталось всего ничего, поэтому давайте быстро пройдемся по 

основным пунктам подготовки к новогодним фотографиям, чтобы ничего не забыть. 

1. Важные детали. Поставьте на зарядку аккумуляторы от фотоаппарата и очистите 

карту памяти. Как бы это просто и смешно не звучало, но батарейки имеют 

свойство садиться в самый неподходящий момент, а карты памяти быстро 

заполняются, особенно если вы готовитесь фотогарфировать еще и новогодний 

салют, например. Имейте при себе запасные аккумуляторы и карты памяти, либо 

зарядите первые и очистите вторые  

2. ББ. Позаботьтесь о балансе белого заранее. Конечно, если вы снимаете в RAW, то 

можно об этом не сильно беспокоится, но поскольку праздновние Нового года 

наверняка будет в помещении с различным освещением, включая свет от елки, 

гирляд и прочих прекрасностей, баланс белого лучше все же выставить заранее. 

3. Бурные приготовления. Сделайте несколько снимков 

процесса подготовки к празднованию – как накрывают на стол, как вешают 

игрушки на елку, как под елкой лежат подарки или может еще только тайком 

кладутся под елку, как папа надевает костюм Деда мороза  Сфотографируйте 

любые мелочи и детали, которые бы отражали ожидание праздника и стали бы 

отражением теплых традиций вашей семьи. Если у вас есть дети, то пока они не 

спят и не началась полуночная суета, вы можете спокойно пофотографировать 

детей под елкой, с игрушками или без. Конечно, это можно сделать и в любой 

другой день, пока у вас стоит елка, но все же эти мгновения будут ценными, 

особенно если дети празднуют с вами Новый год впервые!  

4. Фото всем! В прихожей можно приклеить на стену ватман с новогодними 

рисунками или еще какой-нибудь небольшой фон, чтобы фотографировать гостей 

как только они придут. Можно подобрать аксессуары: колпаки, снежинки, все на 

что хватит ваше фантазии, и предложить гостям сфотографироваться на память 

сразу же по приходу. Во-первых, это сразу задаст веселый и радостный тон всему 

последующему празднеству, а во-вторых, так у каждого гостя будет хотя бы одна 

фотография,  иначе частенько гости имеют обыкновение расходится без 

фотографий  

5. Подарки-подарки-подарки. Переключите камеру в режим непрерывной съемки 

(continuous burst mode), когда настанет момент разворачивания подарков. Никогда 

не знаешь, когда появится восторженный, или не очень, взгляд ребенка или других 

получателей подарков  Непрерывная съемка поможет не упустить интересные 



моменты, а неудавшиеся кадрые впоследствие просто удаляем, помните, мы 

предварительно очистили всю карту памяти?  

6. Следите за значением диафрагмы. Новогодние 

фотографии могут быть самыми разными – от макро и крупного плана елочных 

игрушек, где открытая диафрагма даст прекрасный эффект блюра и боке, до 

фотографий родных и друзей за новогодним столом, где понадобиться значение 

диафрагмы, закрытое до f/8 или еще больше. Если вы не фотографируете 

зеркалкой в ручном режиме, то вам на помощь могут прийти полуавтоматические 

режимы съемки, в данном случае – режим приоритета диафрагмы (Av). 

7. До и после. Интересным будет фото новогоднего стола, елки и вообще всего места 

проведения празднества в формате “До и После” Только не забудьте 

фотографировать “После” с того же самого места, как и “До”  

8. Вспышка – быть или не быть?! Скорее всего вам придется воспользоваться 

вспышкой, потому что света все-таки будет маловато, поэтому постарайтесь 

отразить свет вспышки, например, от потолка (если, конечно, потолок у вас более 

или менее светлый), так как отраженный свет намного мягче и не будет 

сплющивать лица на ваших новогодних фотографиях. Если у вас нет внешней 

вспышки, то под встроенную вспышку можно подставить зеркальце или 

небольшой белый листок бумаги, чтобы свет от встроенной вспышки отразился от 

зеркальца/бумаги по направлению потолка. 

9. Фотографируйте елку. Елочные гирлядны - особый объект съемки, с которым 

можно получить очень интересные фотографии. Закройте диафрагму и вы 

получите эффект звездочек, откройте диафрагму, отойдите подальше – и перед 

вами чудесный эффект боке! Об этом читайте в отдельных статьях и обязательно 

экспериментируйте! 

10. Праздничный фейерверк. Наверняка в новогоднюю ночь где-нибудь поблизости 

будет праздничный салют или может вы сами устроете небольшой фейерверк, в 

любом случае и к фотографированию салюта неплохо подготовиться заранее, 

просмотрите наши 5 советов о том, как фотографировать салют. 

И самое главное: не забывайте, что Новый год – это прежде всего праздник, и если вы не 

фоторепортер, то вы должны непременно получить удовольствие и от самого праздника! 



 

Мы же желаем вам всего самого прекрасного в Новом 2012 году, пусть волшебство 

никогда не покидает вас и все желания непременно сбываются, и пусть вас 

окружают прекрасные мгновения, достойные запечатления на всю жизнь! До 

встречи уже в Новом  году! 

Делаем боке сердечками! 

В прошлый раз мы разобрались с тем, как получить эффект боке вообще, а сейчас давайте 

посмотрим как можно сделать боке сердечками, елочками и чем еще хотите! 

Суть этого эффекта в том, что изменяется форма диафрагмы, т.е. мы ставим перед 

объективом плотную картонку с вырезанной формой боке, которая нам нужна,  и 

фотогарфируем при максимально открытой диафрагме, как было показано в статье о том, 

как получить эффект боке на фотографии. 



 

Это фото я назвала "С любовью к Дубаи" Технически же - это елочная гирлянда на 

заднем фоне и картонка с отверстеим в форме сердечка на объективе. 

Придерживать картонку одной рукой очень неудобно, так что самый простой способ 

получить собственное боке – это сделать его собственноручно. А это у нас получится на 

раз, два, три. 

1. Вырезаем из плотной черной бумаги круг, диаметром с объектив, которым вы 

собираетесь фотографировать.  Для этого переворачиваем объектив, обводим его 

на бумаге, вырезаем по внутреннему краю чуть меньше, чтобы кружок плотненько 

поместился в объектив. В принципе, вырезать можно на бумаге любого цвета, 

однако, если она будет светлая и тонкая, но границы формы боке будут нечеткими 

и часть света может пройти через эту бумагу, поэтому лучше отдать предпочтение 

плотненькой бумаге. 

2. Вырезаем форму боке. Чтобы получить красивое боке, необходимо вырезать 

форму боке по центру круга, поэтому либо  сворачиваем круг вдвое/вчетверо, либо 

просто рисуем карандашиком несколько радиусов и прорисовываем форму боке, а 

потом вырезаем. 

3. Вставляем с внешней стороны объектива и фотографируем с настройками для 

получения эффекта боке. 

Если на фото у вас не получилось боке сердечком или другой произвольной формы, то 

скорее всего проблема в размере сердечка, потому что самый каверзный вопрос в этом 

деле - размер формы боке. 

Какого размера сердечко, например, нужно вырезать, чтобы получить боке не 

наполовину сердечком, а цельное, красивое ? 

Самым правильным будет метод научного тыка, потому что объективы, светосилы 

каждого из них и расстояния от объекта съемки до фона в каждом случае различны, 

однако в качестве ориентира можно запомнить следующее: 



Значение диафрагмы f/х означает всего лишь отношение фокусного расстояния к 

диаметру диафрагмы, поэтому на 50мм объективе с установленным значением диафрагмы 

в f/2, диаметр диафрагмы будет 25мм, поэтому вырезаемая форма боке должна быть 

меньше 25мм в своей наиболее широкой части. 

 

По этой же логике, эффект боке сердечком можно получить и на китовом объективе 

18-55мм, на самом дальнем фокусном расстоянии в 55мм и значении диафрагмы в 5,6, 

вырезаемая форма боке не должна превышать 9мм в самой широкой части. 

Если вам не охота тратить время на вырезание сердечек, звездочек, ёлочек и всего прочего 

самостоятельно, готовые комплекты можно купить, в различных интернет магазинах, 

просто прогуглите Bokeh Master kit. Стоимость правда составляет около 25$ + доставка. 

Эффект боке сердечком можно получить и обыкновенным цифровым фотоаппаратом, 

самой что ни на есть мыльницей. Вот это фото, например, сделано цифрокомпактом, 

правда на близких объектах эффект боке не получится, а вот на дальних, как уличные 

фонари и огни города, – без проблем. 

 



Как сделать панораму: подготавливаем 

фотографии!  

При съемке пейзажей, архитектурных памятников или городских пейзажей даже самый 

широкоугольный объектив, тем более при камере с кропом, т.е. неполноформатной 

матрицей, может не дать такого обзора и эффекта присутствия, который достигается при 

использовании панорамы. Более того, поскольку в панораме соединяются несколько 

картинок снятных на вашу n-мегапиксельную камеру, окончательное изображение 

получается более детализированным, чем та же сцена, снятая одним кадром. Именно этим 

и обусловлена такая сверхдетализация самого большого фото в мире. Ваше желание снять 

панораму, надеюсь, только усилилось  

 

 

Панорама Сиднея из 8 фотографий. Фотограф: Юрий Прокопенко 

Итак, приступим! Для создания красивой панорамы нам необходима серия фотографий, 

так что давайте для начала разберемся как снять и подготовить фотографии для панорамы, 

поскольку именно это определяет качество окончательной фотографии панорамы. А 

склеивать фотографии будем в следующем уроке – как сделать панораму в фотошопе  

1. Для начала продумайте композицию кадра – что вы хотите включить, а что нет? Что 

будет на переднем, среднем и заднем плане фотографии? Например, море, конечно, 

прекрасно, но панорама просто моря без кораблика, солнышка или хотя бы кусочка берега 

будет смотреться достаточно уныло. Взгляду нужно за что-то зацепиться на фотографии. 

 

2. Используйте штатив. Серия фотографий для панорамы должна быть снята со штатива, 

по крайней мере это крайне желательно, поскольку в таком случае сохранится 

правильный угол обзора и вам будет легче контролировать перекрытие кадров. 

Прекрасно, если на вашем штативе есть уровень, который поможет изначадбно выровнять 

горизонт и не завалить его. Если на штативе его нет, то можно купить отдельный 

специальный уровень, одеваемый на горячий башмак камеры и вперед – фотографировать 

панораму! Такой уровень стоит порядка 15-20 долл. 



  

3. Для панорамы необходимо сделать фотографии с перекрытием примерно на 

четверть, т.е. не нужно пытаться соединить кадры “на глаз”, это за вас будет делать потом 

программка. На данном этапе нужно дать программке простор для стыковки кадров, 

поэтому лучше сделать больше перекрывающих друг друга кадров, нежели потом 

оказаться перед фактом пропущенного или нестыкуемого объекта на панораме. 

4. Используйте одинаковое фокусное расстояние для всех снимков одной серии 

панорамы. Причем желательно, по возможности маленького, чтобы дать больший охват 

сцены. 

5. Не изменяйте экспозицию кадра, а лучше и все параметры съемки – диафрагму, 

выдержку и светочувствительность – оставьте одинаковыми во время фотографирования 

всей серии для панорамы. Для этого переключитесь в ручной режим фотографирования и, 

найдя подходящие настройки, не изменяйте их. В противном случае, вы можете получить 

панораму с разными участками – светлее или темнее, более или менее шумными (если, 

например вы изменили ИСО по ходу) и так далее. 

 

Панорама из 15 фотографий. Автор фото панорамы: Kaj Bjurman 

6. Фотографируйте в ручном режиме фокусировки. Авто фокус на разных кадрах будет 

фокусироваться на разных объектах, что приведет к тому, что в окончательной версии в 

одной части панорамы будет в фокусе близлежащий куст, например, а в другой – дальний 

холмик. Человеческий глаз бессознательно это сразу засечет Поэтому при 

фотографировании панорамы делаем так: в режиме автофокуса фокусируемся на каком-

нибудь объекте, учитывая, что фокусная плоскость сохранится на всех остальных 

снимках, переводим объектив в режим ручного фокуса и фотографируем дальше. 

7. Еще один полезный совет, некогда вычитанный из книги Скотта Келби “Цифровая 

фотография”, сфотографируйте палец перед началом съемки панорамы и два пальца после 

последнего кадра. Хотя я просто закрываю объектив рукой, чтобы получить черный кадр, 

который поможет во всем ряду более или менее одинаковых кадров быстро найти именно 

эту серию для панорамы. 

8. Сфотографируйте все еще раз! На всякий случай, особенно если вы будете 

обрабатывать и склеивать панораму вдалеке от места съемки. 



 

Автор фото панорамы: Richard Brevik 

Итак, делаем фотографии в соответствии с этими несложными правилами о том, как 

фотографировать панораму. А в следующей статье посмотрим, как склеить полученные 

фотографии и сделать панораму в фотошопе. 

 

Панорама рассвета из моего окна 

Как сделать панораму в фотошопе 

В прошлый раз мы научились как фотографировать панораму, теперь самое время склеить 

фотографии в Фотошопе. Сегодня  у нас маленький сюрприз – я записала первый 

видеоурок о том, как сделать панораму в фотошопе, но думаю пошагово расписать 

очередность работы в фотошопе тоже не помешает. А панорама в фотошопе делается на 

раз, два, три! 

1. Выбираем файлы, из которых собираемся делать панораму и открываем их все в 

фотошопе. В принципе можно и не сразу открывать, но по-моему, так удобнее . 

Заходим в пункт меню File -> Automate->Photomerge. Функция Photomerge 

появилась в фотошопе, начиная с версии CS, если у вас более ранняя версия, дайте 

знать, найдем решение! 

Так вот перед вами появится вот такое окошко, где нужно будет выбрать файлы для 

панорамы, а также алгоритм склеивания. 



Если вы уже открыли все фотографии в фотошопе, то просто нажимаете Add Open Files и 

все файлы сразу переместятся в это окошко, если же нет, то нажимаем Browse и выбираем 

те файлы, из которых собираемся делать панораму. 

 

  



В столбике слева представлены алгоритмы склеивания изображений. 

 “Auto” (Авто) фотошоп автоматически подбирает наилучший режим для 

панорамы, трансформирует и сводит вместе исходные фото, а также корректирует 

цвета, при необходимости. 

 “Perspective” (Перспектива)  придает эффект перспективы, используя один из 

исходников (по умолчанию, центральное изображения) в качестве основы и 

трансформируя остальные фотографии для придания эффекта перспективы общей 

картине. 

 “Cylindrical” (Цилиндрическая) придает панораме цилиндрическое искажение, как 

если бы панорама вписывалась во внутреннюю часть цилиндра, а потом 

разворачивалась и размещалась на столе.  Эта опция хороша для широких панорам. 

 “Spherical” (Сферическая) выравнивает и трансформирует изображения так, если 

бы они были вписаны во внутреннюю поверхность сферы – эта опция подходит для 

создания 360 панорам, если вы отсняли фотографии для панорамы в 360 градусов. 

 “Collage” (Коллаж) выравнивает и трансформирует изображения, но не искажает 

их, то есть только поворачивает и пропорционально увеличивает/уменьшает 

исходники. 

 “Reposition” (Только перемещение) просто устанавливает фотографии рядом друг с 

другом, как если бы вы разложили их на столе, при этом не изменяя и не искажая 

изображения. 

В большинстве случаев вариант Auto прекрасно срабатывает, поэтому оставляем его, 

отмечаем галочкой внизу Blend Images Together, который находит оптимальные границы 

между исходными фотографиями панорамы, подставляет их друг к другу и корректирует 

цвета, а также отметьте  Correct Geometric Distortions (Корректировка геометрических 

искажений). Чем больший охват панорамы, тем больше эти искажения, поэтому 

рекомендую все-таки галочку поставить. Если вы склеиваете в фотошопе всего 2-3 кадра, 

объекты на которых находятся примерно на одинаковом расстоянии от вас, то 

необходимости в подобной корректировке может и не быть. 

Победно жмем кнопку … и ждем В зависимости от мощности вашего компьютера, 

размера файлов и их количества, процесс их склеивания в фотошопе может занять 

некоторое время, иногда долгое – ведь фотошоп подбирает кусочки из всех ваших 

фотографий, копирует их в отдельный .psd файл как слои, и каждому слою прикрепляет 

маску, что достаточно удобно для последующей коррекции разных неровностей и 

возможных нестыковок. 

2. Итак, когда обработка в фотошопе сделала свое дело, мы получили вот такую неровную 

картину с некоторыми белыми линиями. Для начала берем инструмент Crop и вырезаем 

кадр, захватывая заполненные области и кадрируя так, как нам надо. 



 

3. Теперь остались белые полосочки, которые исчезнут как только вы объедините все 

слои, поэтому просто жмем на треугольничек во вкладке Layers (Слои) и выбираем 

пункт Flattern Image (Свести вмете слои) 

 

И все – фото панорамы готово! 



 

А вот и видео о том, как сделать панораму в фотошопе, который я записала специально 

для вас, дорогие друзья! Там, кстати, в конце я показываю небольшой прием, как красиво 

обработать и усилить цвета на фото заката или рассвета в фотошопе. Буду рада вашим 

комментариям! 

Что такое баланс белого? 

Если вы хотите получить правильное, качественное изображение, то надо разобраться в 

балансе белого цвета. При желании можно настроить баланс белого непосредственно 

перед съемкой в камере, а можно и после съемки во время постобработки (только при 

съемке в формате RAW). 

Существует такое понятие как «цветовая температура света», с которым мы сейчас и 

разберемся, чтобы логично перейти к понятию «баланс белого цвета». 

 

Итак, все знают, что свет от разных источников имеет различную цветовую окраску. 

Физика нам объяснит этот факт следующим образом: если нагревать любое черное 

физическое тело, то оно будет излучать электромагнитные волны, эти волны 

распределяются в инфракрасном диапазоне. Когда температура поднимется, эти 

электромагнитные волны  будут в диапазоне видимого света. Например, нагретое до 

температуры около 1800-2000 К  черное физическое тело будет излучать красно-

оранжевый свет. 

При условии повышения температуры,  спектр излучения начинает смещаться к более 

холодным цветам, постепенно от  желтого к  зеленому, голубому, синему, фиолетовому и 

далее  будет преход в ультрафиолет и радиоволны. Исходя из этого, для удобства 

терминологии, оттенок света характеризуют  цветовой температурой, обозначаемой в 

Кельвинах. 



 

Наш глаз воспринимает белый цвет, не зависимо от окружающего освещения, но и он дает 

сбой если мы быстро зайдем с улицы, залитой ярким солнечным светом, в помещение с 

желтым светом от лампы накаливания – доли секунды мы будем видеть все с желтым 

оттенком, пока наше зрение не адаптируется. 

У нас срабатывает зрительный анализатор, а современные  цифровые камеры имеют 

электронный анализатор цвета, называемый Автоматическим балансом белого. Приятно и 

удобно когда камера выполняет эту функцию в автоматическом режиме да еще и 

качественно, а если не всегда справляется, то лучше пользоваться предустановками 

баланса белого, заложенными в камере, или настраивать баланс белого вручную. 

 

Пример фотографии с разными настройками баланса белого. Фото: www.graphics.com 



Обычно в камерах бывают следующие предустановки баланса белого 

 Auto – автоматический режим, который отлично срабатывает при съемке днем, 

когда основной источник света – солнце, он также полезен в ситуациях, когда 

источник света постоянно меняется и сложно навскидку угадать его температуру. 

 Daylight – дневной режим, при котором камера добавляет теплые тона в кадр. 

 Cloudy – облачно, здесь опять добавляются теплые тона. 

 Shade – тень, аналогично предыдущей установке баланса балого, но с еще более 

теплыми тонами. 

 Tungsten – вольфрам: камера добавляет холодные тона. Используйте этот режим в 

помещении, где основным источником света являются обыкновенные 

вольфрамовые лампочки или на улице при освещении от ламп накаливания.  

Исходя из того,что  лампы накаливания имеют  больше желтого цвета в своем 

спектре (2600-2900К), то камера должна скомпенсировать это путем добавления 

синего оттенка, противоположного желтому. 

 Fluorescent – флуорисцент: в этом случае камера добавит теплые красноватые тона 

для компенсации холодного оттенка флуорисцентного света. 

 Flash – вспышка: камера опять добавить теплых тонов. 

 Custom – ручная настройка баланса белого, устанавливаемая фотографом. 

Ручная настройка баланса белого –  тема для отдельной статьи, а пока просто 

рекомендация: перед началом съемки сфотографируйте белый лист бумаги или серую 

карту и покопайтесь в инструкции к вашей камере, в следующий раз поговорим о том, как 

настроить баланс белого вручную. 

Макияж для фотосессии: памятка 

моделям 

Добрый день, дорогие друзья! Сегодня у нас в гостях – Сона Абрамян, профессиональный 

визажист, которую мы попросили рассказать о некоторых секретах удачного макияжа 

для фотосессии. Они, конечно, пригодятся в первую  очередь девушкам, собирающимся на 

фотосессию, однако будут интересны и самим фотографам, поскольку часто 

фотографам приходится подсказывать своим клиентам в каком образе быть и чего 

лучше избегать в мейкапе. Итак секреты удачного макияжа для фотосессии от Соны. 



 

Прежде всего следует всегда помнить, что макияж для фотосессии является особым, так 

как в нем важны яркость и фактуры, а так как студийный свет запросто смазывает яркость 

и контрастность в макияже, даже самый естественный макияж требует значительных 

усилий визажиста. 

Основа макияжа для фотосессии 

В целом макияж для фотосессии должен быть ярче, чем в повседневной жизни, однако 

ярче – не значит блестяще. Макияж для фотосессии должен быть матовым, отдайте 

предпочтение светлым тонам и пудре, чтобы от вспышки не было бликов на лице. При 

этом пудра должна быть натурального тона и бежевого оттенка, бесцветная или 

прозрачная пудра может придать лицу неживой бледный цвет. 

  

  

Чтобы скрыть недостатки кожи нам понадобится плотный слой грима. Однако до это 

воспользуйтесь цветными консилерами, маскировочными карандашами, которые помогут 

выровнять цвет лица. Корректоры бывают разных цветов – бежевого, зеленого и даже 

сиреневого Чтобы не запутаться, запомните пару основных моментов:

 



 Капилляры, прыщики, покраснения, и вообще «лишний» красный цвет 

нейтрализуем зеленым, нам понадобится корректор зеленого цвета. Вообще для 

коррекции покраснений или пигментных пятен нужно нанести корректор и слегка 

растушевать. 

 Сиреневый корректор нейтрализует желтые цвета: желтые пигментные пятна или 

желтизну на лице 

 Бежевый корректор понадобится для области вокруг глаз, добавьте еще немного 

легкой крем-пудры, чтобы тени хорошо ложились и не скатывались. 

Если даже у вас нет корректоров, не беда, воспользуйтесь тональным кремом на пару 

тонов светлее основного цвета лица. Такой тон поможет убрать нежелательные тени, 

синяки под глазами и красноватые места у крыльев носа. Затем аккуратненько 

замаскируйте лицо плотным тональным кремом, и не забудьте также уши, шею и линию 

роста волос. На нос и лоб наносим пудру, так как это самые бликующих части лица на 

фотографии. 

Для области глаз важно выбрать средство легкой текстуры, поскольку слишком плотный 

корректор может морщины под глазами. Когда вы перейдете к пудре, будьте аккуратнее к 

области  вокруг глаз, где перебор пудры создаст «эффект мешков» или подчеркнет 

морщинки. 

Корректируем нос макияжем 

Чтобы сделать нос визульно более миниатюрным, нанесите более темный тон на боковые 

части и крылья носа, а посередине – линию посветлее. 

Длинный нос также можно укоротить пудрой темнее основного тона. Проведите пудрой 

темного цвета по перегородке носа между ноздрями до самого его кончика. 

Та же пудра или румяна помогут скрыть пухлость щечек и визуально сделать лицо 

тоньше. Просто нужно несколько оттенить темной пудрой или румянами нижнюю часть 

скулы и все, что хотите скрыть. При этом румяна нужно наносить не только на скулы, но 

и на лоб, ушки и подбородок, чтобы лицо выглядело свежее. Помните, что оттенок румян 

должен гармонировать с цветом губной помады. 

Подводим глазки: правильный макияж глаз 

 

Скажу вам по секрету, правильный макияж глаз может любые глаза сделать визуально 

шире почти в полтора раза. Нам понадобиться всего лишь волшебный белый карандаш. 

Прорисовывем им линию между ресницами и глазным яблоком у внешнего уголка глаза и 

рисуем небольшую белую стрелку по направлению к виску. 



Брови также лучше подкрасить, но не карандашом, а тенями, затем хорошенько их 

расчесать и закрепить капелькой мусса для волос, но ни в коем случае не геля или лака, 

чтобы брови на фото не блестели. 

Если вы не сильны в подборе разных цветов макияжа глаз, запомните простое правило: 

комбинируем темный и светлый оттенок одного и того же цвета, однако обязательно 

мягко растушевывем, чтобы переход цветов был плавным. 

Губки 

Светлая помада сделает губы визуально полнее, однако на черно-белом фото может 

слиться с цветом лица. Но выход есть всегда: наносим более светлую помаду на середину 

губ, а боковые части и контур прокрашиваем помадой темнее и делаем плавный переход 

от одного цвета к другому. 

Вот и все, макияж для фотосессии готов! Теперь остается расслабиться, улыбнуться 

себе-прекрасной и получить отличные снимки  

Что такое экспопара и как правильно 

фотографировать в ручном режиме 

В прошлой статье мы рассмотрели полуавтоматические режимы съемки, 

попрактиковались с каждым из них, теперь настало время понять, как правилько 

фотографировать в ручном режиме. Однако прежде чем приступить непосредственно к 

фотографированию давайте  разберемся как фотоаппарат регулирует экспозицию в 

автоматическом режиме и как нам придется ее регулировать в ручном. 

Помните, в статье про диафрагму мы говорили о том, что каждое последующие значение 

диафрагмы вдвое изменяет количество света, попадаемого на матрицу фотоаппарат. 

Стандартная шкала диафрагмы выглядит следующим образом и каждое изменение 

значения называется ступенью, шагом или стопом диафрагмы 

f/1;  f/1.4;  f/2;  f/2.8;  f/4;  f/5.6;  f/8;  f/11;  f/16;  f/22;  f/32; 

Между ними также бывают 2 промежуточных значения, но именно при изменении 

диафрагмы на одну ступень количество света изменяется в два раза. 

Аналогично, диафрагме выдержка тоже имеет ступени и ее изменение на одну ступень 

приводит к изменению количества попадаемого света в два раза. 

1/4000, 1/2000, 1/1000, 1/500, 1/250, 1/125, 1/60, 1/30, 1/15, 1/8, 1/4, 0″5, 1″, 2″, 4″, 8″, 15″, 

30″ 

Чувствую, что у вас в голове созревает резонный вопрос, а зачем мне все это надо? 

Расскажите лучше как правильно фотографировать! Немного терпения и все встанет на 

свои места. 

Так вот, экспопара представляет собой пару значений диафрагмы и выдержки, при этом 

одно и то же значение экспозиции могут обеспечивать несколько экспопар, например 1/30 

и  f8, 1/60 и  f5.6, 1/125 и  f4 и так далее (совместите мысленно две шкалы, 



представленные выше). В этом вы, надеюсь, убедились, рассматривая полуавтоматические 

режимы съемки, где камера сама подбирала пару для заданного значения диафрагмы или 

выдержки так, чтобы экспозиция не изменялась. 

Теперь эта святая миссия будет возложена на вас Однако, и здесь автоматика приходит 

на помощь! 

 

На дисплее фотоаппарата, а также в нижней части видеоискателя есть шкала с отметкой 

EV, значениями от -2…-1…0…+1…+2 и бегунком. Вот этот бегунок-то и подскажет, 

какова будет экспозиция при выбранных значениях диафрагмы и выдержки. Если он 

смещается влево к отрицательным значениям, то кадр будет недоэкпонированным, а если 

вправо, то переэкспонированным. Вашей задачей для начала будет поставить ISO в 

зависимости от условий освещения, и изменяя диафрагму и выдержку получить 

нормальную экспозицию. 

Если вы не знаете, с каких значений начать, то можете воспользоваться несложным 

универсальным Солнечным правилом шестнадцати: 

Чтобы получить нормальную экспозицию в яркую солнечную погоду поставьте значение 

диафрагмы f/16, а выдержку и ISO  – обратные значения, т.е например, 1/100  и ISO 100; 

1/200  и ISO 200; 1/400  и ISO400 и т.д. 

Если же день облачный, откройте диафрагму до f/8, а остальные значения поставьте по 

аналогии с предыдущим примером. 

Это правило может служить отправной точкой, а далее корректируйте значения 

параметров, уже зная о том, к чему приведет изменение диафрагмы и выдержки на один 

стоп, и следя за бегунком, показывающим уровень экспозиции. 

Понять как правильно фотографировать можто только на практике, потому что  все 

зависит от освещения в каждой конкретной ситуации. Да и понятие правильного 

относительно, вы же помните, мы рисуем светом! Вы  скоро научитесь быстренько 

оценивать свет и выставлять правильные параметры, надо просто набить руку  

Итак, помня о том, что увеличение диафрагмы и сокращение выдержки на один стоп 

оставит экспозицию неизменной, тогда как увеличение или уменьшение одного из 

параметров на один стоп приведет к освещению или затемнению кадра в 2 раза, начните 

потихоньку фотографировать в ручном режиме, поиграйте с параметрами, вернитесь в 

полуавтоматический режим, чтобы посмотреть, как это делает автоматика, и 

фотографируйте, фотографируйте и фотографируйте! 



Вы определились, что будете снимать и какого эффекта хотите достингуть? Помните об 

особенностях длинных и коротких выдержек и открытой/закрытой диафрагмы? Тогда 

вперед, целый мир фотографии и ручных настроек ждет вас! 

Как сделать эффект сепии на фото: 5 

простых способов 

Эффект сепии в фото наверняка знаком многим – коричневатые фотографии, под 

старину, действительно добавляют особый эффект фотографиям. 

В переводе с греческого “сепия” значит “каракатица”, поскольку краска сепия 

изготовлялась из чернильного мешка морского моллюска – каракатицы. Сепию 

использовали европейские художники при рисовании кистью или пером еще с середины 

XVIII в. 

Сепия – это краска, которая в натуральном виде иногда применяется при тонировании 

фотографий в коричневый цвет. Интересно, что при проявке фотографий с применением 

сепии металлическое серебро превращается в сульфид, который более устойчивый к 

выцветанию, и именно поэтому многие старые черно-белые фотографии, сохранившиеся 

до наших дней, имеют коричневатый оттенок, – у них просто больше шансов сохраниться. 

 

1. Самый простой способ создания эффекта сепии на фото: открываем понравившуюся 

картинку в фотошопе, в окошке со слоями двойным щелчком мышки фоновом слое 

превращаем его в обыкновенный слой, к которому теперь будем применять стили. В 

панели стилей выбираем “sepia tone” и вуаля – эффект сепии на фото готов! Можно 

немного добавить контраста, потому что в этом случае конрастность цветов теряется. 

Если вы внимательно посмотрите, что же стало со слоем, то заметите, что к нему всего 

лишь применился эффект наложения цвета (color overlay) вот этого оттенка #e1d3b3 

Главный плюс данного метода в том, что вы получаете эффект сепии на фото  в два 

щелчка мышкой  



  

 

2. Photo filter 

Суть этого метода в том, что вы добавляете корректирующий слой с определенным 

оттенком, в данном случае сепией. Сначала необходимо сделать начальное фото черно-

белым, используя Image>Adjustments>Desaturate или несложную комбинацию клавиш 

Ctrl+Shift+U. 

В нижней части окошка слоев есть значок в виде черно-белого кружка под названием 

Create new fill or adjustment layer, вот на него и кликаем и выбираем из выпадающего 

списка пункт  Photo filter. В появившемся окне можно выбрать, какой именно фильтр вы 

хотите применить, в частности Sepia,  или установить желаемый цвет фильтра, потом 

регулируете его насыщенность ползунком % и желательно оставляете галочку у опции 

сохранения света (Preserve luminosity), чтобы светлые участки фотографии при сепии 

также остались светлыми. 

И вот результат: 



 

  

3. Дуотон 

По своей сути сепия представляет собой дуотон (или дуплекс) – черно-белое изображение 

с использованием дополнительного цвета, где может использоваться вплоть до 4х цветов. 

В зависимости от количества используемых цветов эти режимы называются дуотон, 

тритон или квадротон. Для работы с дуотонами у фотошопа есть особый режим, для 

перехода в который необходимо для начала “избавиться” от цвета на фотографии, то есть 

просто перевести ее в режим серого, вот так: Image>Mode>Grayscale, а затем в дуотон 

Image>Mode>Duotone. Далее в выпадающем окошке есть готовые установки с 4 

предустанвками сепии, в основном тритоны, т.е. с использованием трех цветов. 

Выбирайте любой! 



 

4. Вариации 

 

Еще один простой способ получения эффкта сепии в фотошопе - это использование 

вариаций. Как обычно, сначала необходимо подготовить исходную фотографию, т.е. 

перевести ее в черно-белый режим одним из способов, с которыми вы уже знакомы. Если 

необходимо, орегулируйте яркость и контраст. 

Выбираем меню Image>Adjustments>Variations и убеждаемся, что выбраны Midtones, 

поскольку нас интересует изменение именно средних оттенков, и передвиньте бегунок 

Fine/Coarse на одно-два деление влево. После установки этих значений кликаем по одному 

или два раза (в зависимости от фотографии и эффекта, которого вы хотите достичь) на 

Red и Yellow, т.е. добавляем немного красного и желтого к средним оттенкам нашего 

изображения: 



 

и вот результат: 



 

5. Смешение каналов 

Эффект сепии в фотошопе можно также получить путем смешения каналов. Для этого 

нам необходимо предварительно сделать фото черно-белым, далее заходите в меню 

Image>Adjustments>Channel Mixer и устанавливаете следующие значения для каждого 

канала Red: 30%, Green: 70% Blue: 10% и constant  5%. 



 

Вот такие незамысловатые методы получени эффекта сепии на фото в фотошопе. Какой 

из методов создания эффекта сепии в фотошопе вам удобнее и какой вариант больше 

понравился? 

3 простых способа создания черно-белой 

фотографии с элементами цветного 

В этом уроке мы рассмотрим тройку незамысловатых приемов, которые помогут вам 

сделать черно-белую фотографию с элементами цветного. В реальности способов 

огромное множества и получить такое фото можно в пару кликов. Конечно, для каждой 

фотографии может быть более удобен тот или иной способ, но важен принцип и умение 

работать с несколькими полезными инструментами, а остальное – простор для вашей 

фантазии! 

Способ №1. Можно даже не особо раздумывать и просто запомнить вот эти комбинации: 

Ctrl+J (дублирует слой) 

Ctrl+Shift+U (делает верхний слой фото черно-белым, Image->Adjustment->Desaturate) 

и стираете мягим 50% ластиком те участки черно-белого фото, которые вы хотите 

оставить цветными. 

Способ №2. Этот способ получения черно-белого фото с элементами цветного 

аналогичен первому за исключением того, что черно-белое фото будет получено другим 



способом. Дело в том, что в некоторых случаях Desaturate порождает шумы на черно-

белом фото и перевод в режим Grayscale дает лучший результат. Здесь вы получите черно-

белое фото с элементами цветного буквально в 3 шага. 

Шаг 1. Дублируем файл, чтобы ненароком не испортить исходник, а сделать это можно с 

помощью Image->Mode->Dublicate… и переводим копию нашего цветного фото в черно-

белое путем изменения режима из RGB в Grayscale вот так: Image->Mode->Grayscale. На 

вопрос фотошопа о том, действительно ли мы хотим удалить всю информацию о цвете, 

уверенно отвечаем Да! 

 

Шаг 2. Таким же способом переводим изображение опять в режим цветного Image-

>Mode-> RGB, это, конечно, фотографии не добавит цвета, однако позволит в следующем 

шаге добавить цветные элементы. В режиме Grayscale этого сделать не удасться.  

Шаг 3. Берем инструмент History brush, устанавливаем 50% жесткость кисти, 

размер подбираем в зависимости от участка, который необходимо перевести в цветной, и 

прорисовываем желаемые области. Если что-то не получается, Ctrl+Z вам в помощь! 

 



Способ №3. Ну и третий способ также аналогичен предыдущим, однако позволяет легче 

работать с более сложными выделениями, например, букетом цветов, которые вы хотите 

оставить цветными на черно-белой фотографии. 

 

Для начала повторяем те же шаги, что в 1-ом способе, чтобы получить 2 слоя – один 

цветной, другой черно-белый поверх цветного. Создаем маску верхнего слоя – кликаем на 

нем мышкой и нажимаем вот эту кнопочку внизу, у черно-белого слоя появится маска в 

виде белого полотна рядом. 

Если вы не знакомы с принципом работы масок, то в двух словах можно сказать, что цвет 

маски бывает только монохромным – белый, черный и оттенки серого, и показывает 

степень видимости самого слоя. То есть белые области маски не скрывают изображения, 

серые области частично его скрывают, а черные области делают совсем невидимыми. 

В отличие от обыкновенного ластика, при закрашивании черным на маске само 

изображение не стирается и его всегда можно восстановить, закрасив маску белым. Итак, 

щелкаем на маске слоя (а не на самом слое!), устанавливаем цвет кисти черный и 

проводим по тем областям черно-белого фото, которые вы хотите оставить цветными. 

Если вы что-то не так закрасили, меняете цвет кисти на белый и закрашивате снова. 

Далее объединяем все слои Ctrl+Shift+E и сохраняем. 



У меня в итоге получилось вот такое черно белое фото с элементами цветного. А у вас? 

 

Устройство фотоаппарата: просто о том, 

как устроен цифровой фотоаппарат 

Часто начинающие фотографы хватаются за новенький 

фотоаппарат, осваивая режимы, меняя настройки и редко задумываясь о том, как устроен 

фотоаппарат? Действительно,  вспоминать физику и оптику особо не хочется, работает 

себе и ладно, но я предлагаю более интересный вариант – давайте пройдемся по основным 

частям устройства цифрового фотоаппарата, а вместо нудных схем и долгих 

объяснений просто посмотрим отличное видео, снятое командой Discovery. 

Фотоаппараты можно разделить на 2 большие группы – цифровые и пленочные, которые 

отличаются друг от друга типом светочувствительного элемента (сенсора). В пленочном 

фотоаппарате таким элементом является пленка, а в цифровом фотоаппарате – матрица. 

Матрица – это пластина с большим количеством светочувствительных элементов, и 

именно от матрицы зависит качество фотографий, получаемых в итоге. 

Прежде чем добраться до матрицы свет проходит через объектив и диафрагму, которая 

регулирует количество пропускаемого света и степень размытия фона. Далее все зависит 

от того, какой у вас фотоаппарат. 



 

Цифровые фотоаппараты можно разделить на зеркальные (известная всем зеркалка) и 

незеркальные. Устройство этих фотоаппаратов отличается наличием зеркала, задача 

которого – перенаправить свет в видеоискатель, чтобы вы посмотрели какой кадр у вас 

получается. Когда же вы решите снять кадр и нажмете на кнопку спуска, зеркало 

поднимется и свет пройдет дальше. Сделано это для того, чтобы матрица фотоаппарата не 

находилась под постоянным воздействием света, в результате чего она может нагреваться 

и в итоге раньше выходить из строя. 

В “мыльницах” и “цифрокомпактах” же нет зеркала и свет попадает прямо на матрицу в 

течение всего времени съемки, когда вы наблюдаете изображение на дисплее вашего 

фотоаппарата. 

Но не все так просто в устройстве цифрового фотоаппарата – прежде чем дойти до 

заветной матрицы, свету нужно пройти через затвор, створки которого открываются и тут 

же закрываются. Время, на которое этот затвор открывается, и есть выдержка. 

Весь этот процесс управляется процессором (микроконтроллером), который управляет 

работой затвором, объективом, выбирает баланс белого, определяет экспопару, управляет 

вспышкой, специальными эффектами (вроде сепии, черно-белого и прочими вашими 

настройками), выводит картинку на дисплей, а потом конвертирует полученный кадр в jpg 

или сохраняет в raw (смотря как вы настроите), записывая на карту памяти и пр. 

Свадебные фотографии от А до Я 

 

Что волнует невесту в первую очередь? Боязнь, что жених сбежит прямо из Дворца 

бракосочетания. Нет, вряд ли. Скорее всего, ее пугают фотографии, которые она получит 

после церемонии. А, вдруг, все пойдет не по плану и на снимках она будет похожа на 

популярного зеленого тролля из мультика для семейного просмотра? Такие фотографии 

не покажешь коллегам по работе и уж точно не выложишь на всеобщее обозрение в 

социальную сеть. 

http://photolunch.ru/wp-content/uploads/2012/05/182849-1024x768.jpg


Услуги фотографа в столице нашей родины предлагают огромное количество людей, 

разумеется, среди них есть и профессионалы своего дела. Они точно не испортят кадр 

плохим светом или трясущимися руками. Но встречаются и дилетанты, которые купили 

дорогую профессиональную камеру в ближайшем магазине электроники и по неведомым 

миру причинам возомнили себя гениями фотографии. Нарваться на таких в день свадьбы 

– большая беда. 

Поэтому подойдите к поиску фотографа также ответственно, как и к поиску будущего 

мужа. Поспрашивайте друзей. Наверняка, у них есть парочка достойных кандидатур. 

Параллельно начните поиск в сети Интернет, смотрите фотографии, ведите переписку с 

молодоженами. Все эти действия помогут вам выбрать хорошего мастера. 

Потом определитесь с жанром свадебных фотографий. Мы вкратце расскажем обо всех. 

Во-первых, это студийная съемка. Она проводится за несколько дней до свадьбы в 

тепличных условиях. Вы вместе с парикмахером и визажистом приезжаете в студию и 

целенаправленно позируете фотографу на фоне различных задников. Чаще всего, это 

обычная однотонная материя. Реже в студиях воссоздают интерьер роскошных особняков. 

Во-вторых, это постановочная фотосессия. Она похожа на студийную, но проводится в 

основном на улице и во Дворце бракосочетания. Фотограф советует, какие позы вам 

занять, ищет интересные декорации. 

В-третьих, это репортаж. Вы с женихом переезжаете с одного места на другое, а фотограф 

следует за вами словно тень. На свою камеру он фиксирует все самые важные события, 

стараясь точно передать не только факты, но и эмоции. 

Фотограф на мероприятие – желанный гость. Он должен обладать не только 

профессиональными навыками, но и другими врожденными качествами. Одно из них, 

способность располагать людей к себе, нравиться им, вызывать доверие и уважение. 

Конечно, всему этому можно научиться, но врожденный талант чувствуется за версту. Его 

выдает искренность и прямота. Именно такого талантливого от рождения фотографа мы и 

желаем вам отыскать. С ним вы получите идеальные свадебные фотографии, которыми 

сможете по-настоящему гордиться. 

 

 


